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Notices
The information in this document is subject to change without notice. No warranty of any kind is made with regard to this 
material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. No 
liability is assumed for errors contained herein or for incidental or consequential damages in connection with the furnishing, 
performance, or use of this material. This document contains proprietary information that is protected by copyright. All rights 
are reserved. No part of this document may be photocopied, reproduced, or translated into another language without prior 
written consent.

Trademark Acknowledgements
Windows is a registered trademark of Microsoft Corporation. All other trademarks are the property of their respective owners.

Printing History
Edition 1.0, #190401, Copyright 2019, DTM Print GmbH. All rights reserved.

FCC Compliance Statement
This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may 
not cause harmful interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation.

For Users in the United States:
This product is intended to be supplied by a UL listed Direct Plug-In Power Supply marked “Class 2”or a UL listed ITE Power 
Supply marked “LPS” with output rated 12VDC, 4.5A or higher. This equipment has been tested and found to comply with 
the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. In a domestic environment this product may 
cause radio interference, in which case the user may be required to take adequate measures. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures: following measures:

• Re-orient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cables is required to comply with the Class B limits of Part 15 of the FCC Rules. You are cautioned that any 
changes or modifications not expressly approved in this manual could void your authority to operate and/or obtain warranty 
service for this equipment.

For Users in Canada:
This digital apparatus does not exceed the Class B limits for radio noise for digital apparatus set out on the Radio Interference 
Regulations of the Canadian Department of Communications.

Caution
	» TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THE UNIT TO RAIN OR MOISTURE
	» TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE EXTERIOR PANELS.
	» NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL
	» OPERATE WITH ONLY THE PROPER ELECTRICAL SPECIFICATIONS AS LABELED ON THE PRINTER AND AC ADAPTER.
	» THIS PRODUCT CONTAINS A LASER DIODE OF A HIGHER CLASS THAN 1. TO ENSURE
	» CONTINUED SAFETY, DO NOT REMOVE ANY COVERS OR ATTEMPT TO GAIN ACCESS TO THE INSIDE OF THIS PRODUCT. 

REFER ALL SERVICING TO QUALIFIED PERSONNEL. THE FOLLOWING LABEL APPEARS INSIDE YOUR UNIT: CLASS 1 LASER
	» USE OF CONTROLS OR ADJUSTMENTS OR PERFORMANCE OF PROCEDURES OTHER THAN THOSE SPECIFIED HEREIN 

MAY RESULT IN HAZARDOUS RADIATION.
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Section 1:	Getting Started
	 Thank you…

... for choosing an LX500e/LX500ec/RX500e Color Label Printer. The LX500e Printer will print razor-sharp text and barcodes, 
vibrant colours, and even stunning photo-realistic photographs directly onto rolls of labels, card stock and fan-fold stock. 
The LX500ec adds an integrated cutter to cut between each label. The RX500e adds the ability to encode to label stock with 
integrated RFID chips. It has has a built in cutter. This User’s Manual is your complete step-by-step guide to quickly and easily 
setting up and printing with your new Color Label Printer!

1 A	 Choosing a Good Location
	» Place the printer on a flat surface in a location with adequate air circulation to prevent internal heat build up.
	» Do not place the printer near heat sources such as radiators or air ducts, or in a place subject to direct sunlight, excessive 

dust, mechanical vibration or shock.
	» Allow for adequate clearance in front of the printer to accommodate the printed label stock as it is leaving the printer 

to avoid the possibility of binding or jamming of the label stock. 
	» Allow for adequate overhead clearance for opening the top cover to allow easy access to the label stock and ribbons.

1 B	 Unpacking and Inspection
While unpacking your printer, inspect the carton to ensure that no damage has occurred during shipping. Make sure that 	
all supplied accessories are included with your unit. The following items should be included:FX510e Foil Imprinter

	» Printer
	» Power Adapter
	» Separate Power Cord
	» 6’ USB Cable (If other USB cable is used, it must be 6’ (2 M) or less.)
	» Colour Ink Cartridge
	» Starter roll of high gloss label stock
	» Warranty Statement and Registration Card
	» This manual and other printed information

Save the carton and packaging materials. They will come in handy when transporting the printer.
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1 C	 Identifying the Parts
This illustration shows the front of the printer with its control buttons and LED indicator light.

The Ink Low LED will illuminate when a cartridge has 10% or less of its ink remaining.

The Power LED indicates that the printer is on and ready to receive print jobs.

The Ink Button moves the carriage to the center to allow for loading of the ink cartridge. Once the cartridge is loaded, press 
the ink button again.

The Load/Feed Button is pressed in order to load label stock or form feed the label stock through the printer.

The Unload Button will unload the installed label stock by reversing it through the printer. Make sure to tear off the printed 
labels before pressing the Unload Button.

The Label Tear Bar is a serrated edge for conveniently tearing your finished labels from the printer.

This illustration shows the input ports and power switch found on the rear panel of the printer

Unload Button

Ink Button

Power LED

Load/Feed Button

Ink Low LED

Label Tear Bar

Top Cover

Label Stock TOF 
Sensor Bar

RFID encoder 
(RX500e Only)

USB PortPower Switch Power Input PortFan-fold Label Slot
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Section 2:	Hardware and Software 		
	 Setup

2 A	 Installing Label Stock
Your printer will utilize a wide variety of paper label stock. As long as the label stock is paper and can receive ink jet printing 
and is within the allotted size, it will work in the printer. Primera carries a large variety of paper label stock that has been 
converted and ready for use with your printer.

1.	 Open the Top Cover.

2.	 Pull the spring loaded label stock guide out far enough to fit the label stock.

3.	 Remove any shipping tape from your label stock roll to ensure that it can unroll freely, making certain that no adhe-
siveportion is exposed. It is important to note that any exposed adhesive surface can attach itself to the inner workings 
of the print mechanism and cause a media jam.

Note: 	If you are using fan-fold label stock or label stock other than standard square / rectangular die cut labels, see Sections 2B  
	 and 2C for additional instructions.

4.	 Place the label stock between the stock guide rollers and release the spring loaded stock guide to hold the label 
stock. The stock guide rollers allow the label stock roll to move freely.

Stock Guide Rollers

Label Stock Guide
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5.	 Place the leading edge of the label stock between the throat guide and the side of the printer.

6.	 Quickly continue feeding the label stock further into the printer until you feel resistance from the feed rollers. The 
printer will sense the label and automatically feed it through the printer. If the printer fails to feed the label stock, 
press the Load/Feed button to manually engage the feed roller while continuing to guide the label stock into the 
printer.

Tip! 	 To ensure that the label stock is fed straight be sure to push the label stock into the printer quickly until the 
	 entire front edge of the stock is touching the feed roller. For wider stock use both hands to feed the stock to maintain  
	 even forward pressure while you are pushing the stock into the printer.

2 B	 Adjusting the Stock Gap Sensor Position
The stock gap sensor (TOF Sensor) “sees” the gap between label stock by shining light from the top of the label and attempt-
ing to read that light from a sensor on the bottom. By default, this sensor is set to read the gap .5” from the left side of the 
label stock. If the gap in your label stock intersects with gap position as shown on the slide bar you do not need to adjust 
this and you can skip this section. This does not need to be adjusted for most label stock.

Throat Guide

in.
mm

0.5
12.7

1.0
25.4

1.5
38.1

2.0
50.8

Power

Ink

Ink Load/Feed Unload

Intersection Point

Gap between Labels

Gap Sensor Position
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If you are using label stock other than standard square / rectangular die cut labels such as circular die-cut labels or through-
hole stock use the instructions below to adjust the label stock TOF sensor

Circular Labels

If you are using Circular Labels you must adjust the Stock Gap sensor to correspond with the very top of the label where the 
circles are closest together. If the sensor is too far to the right or the left the printer will still sense the label but the image 
may be offset downward because the printer will start printing at the wrong position. If you are using stock that has multiple 
labels across make sure the sensor corresponds to a place on the stock that has a label and not a vertical gap.

The Sensor Bar has a guide in inches and millimeters that will help you identify where to set the bar to align the sensor 
over any identifying mark or top of a circular shape. To do this, measure the distance from the edge of the label stock to the 
correct position on the stock. Set the sensor bar to this measurement. For example, if you have a two inch circular die-cut 
label, measure from the edge of the label stock to the center of the circle. For this example it should be about 1 1/8 inches. 

Set the Sensor Bar to this value.

Through Hole Labels

If you are using card stock or label stock that has a hole punch or a notch to identify a transition from backing to label, you 
can adjust the Sensor Bar to position it over the identifying mark. To adjust the sensor position use a pen to move the slide 
bar to the correct postion.

Gap Sensor Slide Bar

0.5 1.0 1.5 2.0
12.7 25.4 38.1 50.8mm

   in.

Center
of Circle

1 1/8”
1/2”

Center
of Hole

Through-Hole LabelsCircular Labels
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2C	 Using Fan-Fold Label Stock
It is possible to use fan-fold label stock by feeding it through the fan-fold slot in 
the the back of the printer. 

Before feeding the fan-fold stock through the back of the printer, lock the stock 
guide in the out position so the stock guide rollers will not interfere with the 
label stock. The stock guide is spring loaded and under normal circumstances it 
will pinch any label stock roll inserted into the printer. 

To lock the stock guide push the tab located on the bottom of the moveable 
stock guide to the out/locked position.

 
2D	 Installing the Ink Cartridge

When the cartridge reaches 10% remaining you will be prompted via the Status Monitor to replace the cartridge. If quality 
still looks acceptable you can choose to ignore this warning. However, you may waste labels if the cartridge runs out of ink 
before the next warning at 0%. If you choose to replace the cartridges follow the procedure below.

After installing a new cartridge, you may choose to run an alignment print to achieve maximum quality. However, this will 
require cancelling the print job. If you would like to enable smooth transitions between ink cartridge changes, you may 
choose to disable alignment print warnings. (See the next section).

1. Open the Top Cover of the printer.

2. Press the Ink Button on the printer.

3. The Cartridge Carrier will align itself to the center of the print area.

4. Press the Cartridge Cover Release to open the Cartridge Holder. Remove the cartridge (if installed).

5. Remove the new Cartridge from its packaging. Be sure to remove the protective tape covering the copper contacts.

6. Replace/install the cartridge copper end first.

Stock Guide

LockedUnlocked

Remove tape

Power

Ink

Ink Load/Feed Unload
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7. Push cartridge cover downward until it snaps in place.

Note: Ink Cartridge Levels are estimates based on analysis of the printed images by the driver during spooling. This analysis  
	 estimates the number of ink droplets(spits) required to print the image and subtracts that amount from the total  
	 amount in the cartridge. It displays the total remaining spits as a percentage. In other words, there is no real time  
	 sensor that shows the actual amount of ink in the cartridge.

8. Press the Ink button on the printer to indicate the new cartridge is now installed. You will be prompted to align the 
cartridge. A warning will appear stating that you must have installed label stock that is equal to or larger than 4” x 2” 
(101.6 mm x 50.8 mm). If your label stock meets this requirement click OK to align the cartridge. If your stock does 
not meet this size requirement see the next section before clicking OK.

2E	 Aligning the Ink Cartridge
Cartridge alignment will align the Colour Cartridge for bidirectional printing and calibrate the printer to each individual 
cartridge. You will automatically be prompted to perform this alignment each time you install a new cartridge. You may also 
manually align the cartridge via the status monitor.

For Alignment you will need to have installed label stock that is equal to or larger than 4” x 2” (101.6 mm x 50.8 mm). If your 
stock does not meet this requirement you can use the sample roll that came with the printer for this purpose. You may also 
choose to disable alignment via the settings area of the status monitor.

Disable Alignment: If you would like to enable smooth transitions between ink cartridge changes, you may choose to 
disable alignment print warnings. Alignment improves print quality if Bidirectional printing is enabled. It is not necessary if 
Bidirectional printing is disabled via the printer driver.

You can disable alignment via the status monitor.2 E	Installing The Label Supply Hub

1.	 Open the status monitor.

2.	 Select the settings tab (fifth tab).

3.	 Uncheck “Require cartridge alignment for best quality.” 

Power

Ink

Ink Load/Feed Unload
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Section 3:	Primera PrintHub
Primera PrintHub is used to interact with the printer for gathering ink levels, maintenance, alignment, cost calculation and 
several other functions. You can use it to manage these functions on multiple LX500e/RX500e printers and other Primera 
label printer models.

PrintHub automatically installs with your printer driver and can be accessed through the printer driver preferences or as a 
program on your Windows start menu.

1.	 Connect the printer via USB and turn on the power. The PrintHub accesses most of the information it uses from the 
printer itself so the printer must be turned on and communicating for the program to be useful.

2.	 Go to Start - Programs - Primera Technology - Primera PrintHub.

A. Adjust alignment, sensor mode, output mode, RFID settings and advanced settings.

B. If you have multiple Primera printers connected, they will be listed here.

C. Past jobs will show the last 5 jobs along with cost information. Click the document icon to view a cost report.

D. Application Settings

E. Print Queue shows the currently printing job.

F. Order Link

G. Frequent Activities

H. Current Ink Levels

3 A	 Monitoring Ink Levels
Ink levels can be monitored at any time by using the PrintHub. Immediately after printing starts the PrintHub will display 
the ink levels in the upper right corner of the application. Ink is displayed in 10% increments. Example 100% to 90% to 80%.

H

G

F

E

D

C

B

A
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3 B	 Using the Cost Estimator 
The cost estimator is found under the queue section on the first tab of the PrintHub. The last five job costs are stored in the 
list. Each job will show the cost per label based on the cost per cartridge entered below the list. Enter the actual cost of the 
cartridge you paid. Prints remaining on the currently installed cartridge and total prints on new cartridge are both displayed.

To see a printable/savable report click on the document icon next to the job you want to see. A report will display the infor-
mation. You can print or save the report from this screen. You can also change the currency using the drop down, change 
the job name or adjust the cost from this screen.

Important Note: The cost per label represents the average cost per label over an entire run of labels. This means that the per label 
		  cost will decrease and become more accurate as the number of labels printed increases. This is because the ink  
		  that is used for periodic cartridge maintenance is divided into a larger number of labels. Primera recommends  
		  printing at least 5 labels for an accurate per label cost.
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3 C	 Set the Stock Sensor Mode
The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To adjust the stock 
sensor mode, open the PrintHub. In most cases you will NOT need to change this setting. By default, it is set to sense standard die-
cut labels. It is only necessary to change this setting if you are using clear labels or any label with a black sensing mark on the back. 

1.	 Connect the printer via USB and turn on the power. The Stock Sensor Mode setting is stored in the printer’s internal 
memory so you will not be able to access it unless the printer is turned on and properly communicating with the 
computer.

2.	 Go to Start - Programs - Primera Technology - Primera PrintHub.

3.	 Click on the Label Feed (3rd tab from left).

4.	 Select the Stock Sensor Mode by clicking on the graphic that most closely corresponds to the stock you intend to install.

5.	 Load the label stock after you have set the sensor mode.

There are three sensor modes:

Die-Cut (Default). If you are using standard die-cut labels that look similar to the graphic, use this setting regardless of the 
size of the label. Also, use this setting for Through-hole label material where a hole is punched through each label or a notch 
is cut in the side.

Reflective. Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates 
the break between labels. Black marks are required on clear label stock rolls, or label where the label waste matrix (waste) is 
left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4 inches or on any stock where 
the print starting position cannot be sensed using the label itself.

Continuous. (Sensor off ) If you have continuous stock with no die-cut, reflective mark or holes, set the sensor type to 
Continuous. This will turn off the stock sensor. In this mode there is no way to set the print starting position. The printer will 
simply start printing the first label and print each subsequent label immediately after that previous one. To produce a gap 
between prints simply add the desired amount of white space to the end of the label being printed.

Important Note: You must also set the Stock Sensor Position (Section 2B) so that the sensor is sensing the correct point on the label 
		  stock.

3 D	 Set the Present or Cut Mode (Cutter Models Only)
Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after 
printing. To adjust the Present/Cut Mode, open the PrintHub program.

1.	 Connect the printer via USB and turn on the power. The Output/Cut Mode Setting is stored on the printer main board 
so you will not be able to access it unless the printer is turned on and properly communicating with the computer.

2.	 Go to Start - Programs - Primera Technology - Primera PrintHub.

3.	 Click on the Label Feed 

4.	 Click on the Output/Cut Mode button. There are different options available which change if the Cutter is enabled 
or disabled. If the Cutter is disabled, the label present options will be available. If the Cutter is enabled the present 
options are no longer available but cut options become available.
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Cutter Options

Cut after button press. This setting will cut after you press the Load/Feed button on the printer. This can be used after one 
label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label.

Cut after label count. This option will cut after the number of labels specified in the toggle box that appears when this 
option is selected. This is useful if you have front/back labels or sets of labels.

Cut after no activity. This setting will cut at the end of a print job if the printer does not receive another print job within 
one second of the last print job in the queue. You can use this feature to cut at the end of multi-copy job, multi-page job or 
multiple individual jobs in the queue.

Cut every label. This setting will cut after every label.

Present Options

Do not present. In this mode the label stock does not move after the last label is printed. This means that part of the last 
label printed is still in the printer. This should be used only if you have a label rewinder attached.

Present after no activity. This setting will present (feed all printed labels past the tear off point) at the end of a print job if 
the printer does not receive another print job within one second of the last print job in the queue. You can use this feature 
to present at the end of a multi-copy job, a multi-page job or multiple individual jobs in the queue.

Present Timer. (Works only with Present after no activity option) Set the time delay from the end of the job to when the label 
is presented. Increasing this value can resolve issues with unnecessary present actions between jobs.
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3 E	 Adjusting Print Alignment
If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably 
are not familiar with an essential part of a label printing - Print Alignment. Standard printers feed a sheet and start printing 
based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment. 
The LX500e/RX500e senses the beginning of the label with an optical sensor and is capable of printing to top, bottom, left 
and right edge. Because of this it is necessary to align the printer to work with specific types of label stock.

The LX500e/RX500e comes factory calibrated to print exactly to the edge of Primera label stock. However, due to variations 
in the left margins and other variables it may be necessary to fine tune these settings at the beginning of each roll. This is 
especially true for other non-Primera brand label stock.

Adjust print alignment using the PrintHub. Go to the Print Alignment Tab (second tab).

Important Note: Before adjusting any values, print the Test Alignment to see how close you are to alignment. The on screen graphic 	
		  is the same as the print which makes it easier to adjust these values.

Three items can be adjusted here:

1.	 Tear off/Cut Position. This value adjusts the position of the last label printed after it 
has been presented for tear off or for cutting. This only applies if the output mode 
is set to “Present the label.” Add to the current value to move the tear point closer 
to the printer. Subtract from the current value to move the tear point away from 
the printer. The value is automatically saved as soon as you set it.

2.	 Left Margin Offset. This value moves the printed label left or right. Add to the cur-
rent value to move the printed label to the right. Subtract from the current value 
to move the printed label to the left.

3.	 Top of Form (TOF). This value moves the print start position up or down on the 
label. Add to the current value to move the printed label down or toward the printer. Subtract from the current value to 
move the printed label up or away from the printer. The value is automatically saved as soon as you set it. You may have 
to make several adjustments to one or more of these values. After each adjustment you can click the Test Alignment 
button to print a small test pattern on the label. This will help you find the proper alignment value.

3 F 	 Settings
There are two areas with Settings in PrintHub.

General application settings that apply to the software and all printers can be found by clicking the blue “Settings” button 
in the lower left. Printer specific settings can be found on the “Printer Settings” Tab.

General Settings

Language. Typically, the language is set to match the language setting in the operating system. However, you can override 
currency settings on the Language Tab.
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Automatic Updates. Automatic Updates will update PrintHub, the printer driver and the printer firmware. Every 7 days 
you will be prompted to update the software if there are any newer versions. You can choose to increase or decrease that 
automate check. You can also perform a check for updates immediately by clicking the “Check for Updates” button. Finally, 
if you would like to receive beta software check the “Check for Beta updates” box.

Printing Preferences. You can choose to close PrintHub after printing completes by checking the “Close this application 
after printing completes” box. PrintHub automatically opens whenever you send a print job to the printer. If you do not want 
PrintHub to open in front of other programs, you can check the “Launch minimized during print” option.

Support. Click the “Generate Support Report” button to generate a zip file on your desktop containing all recent log files. 
Send this to tech support so they can help solve any printing problems.

Advanced. Check the “Generate Printer Status XML” box to create an XML at

“C:\ProgramData\PTI\PrintHub\PrinterStatus.xml”.

Software developers can use this file to display status information such as error messages and ink levels in 3rd party applications.

Printer Settings

Information. This section displays all current driver, software and firmware versions.

Cartridge Maintenance. Here you can adjust the frequency of certain maintenance operations. Increasing the value of 
“Seconds between Maintenance Spits” will decrease ink usage but 
could also cause poor quality printing.

Increasing or Pages between Maintenance Wipes will speed up 
printing but could also cause poor quality printing.

Check the Suppress Alignment message to prevent the window 
from appearing which prompts you to align the cartridge every 
time a new cartridge is installed. Skipping the alignment is faster 
but can result in poor print quality.
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Advanced

Multiple Printer Support. You can install multiple printers to the same computer and use them simultaneously. To do so you 
will need to change the USB serial number identifier of one of the two printers, two of three printers, three of four printers 
etc. To change serial numbers:

1.	 Connect each new printer one at a time. The current USB Serial Number will be displayed.

2.	 Click Generate. It will find the next available USB Serial Number based on the currently connected printers. For the first 
one it should set it to 2 and for the next printer 3 and so on.

3.	 Click Set. You will hear the printer reset and the settings window will turn gray. After it resets you will be able to see the 
settings window again. Keep the printer connected.

4.	 Now you can connect the next printer. Windows will automatically install a new driver for that new printer and name it 
Color Label 500 (Copy 1). You can rename it later by editing the printer properties in the Windows printer list.

5.	 You will now see a second printer appear in the left column – Color Label 500 (Copy 1). Click on it to display information 
about this printer. If this is the last printer, you will connect you are done. If you wish to connect additional printers 
follow through steps 2-4.

Calibrate Paper Sensor. Calibrate the paper sensor if you are receiving TOF errors. The calibration process will prompt you 
to remove all paper/stock from the printer before calibrating.

Restore Factory Defaults. This will set all Print alignment and other calibration settings back to factory defaults.
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Section 4:	Using RFID (PC Only)
4 A	 Setup RFID

Label Stock should have an antennae imbedded between the label adhesive layer and the liner. The antennae should be 
oriented to the front of the label stock and centered within the label.

The RX500e has a fixed RFID Encoder/Sensor which is in the middle of the print area. Each time a job with RFID encoding is 
sent to the printer the printer will automatically find and calibrate to the installed tag. If you would like to determine if the 
RFID Tags are detected before then you can check on the RFID tab within Primera PrintHub.

To test the RFID stock, click the Start Read/Write button.

The RX500e will write and read the chip until you press the “Stop Test” button. 

If successful, you will see the Success entry for each attempt.

If the stock fails the test for any reason, stop the test and try pressing the Auto-Calibrate button. If the stock is still not writing/
reading refer to the RFID tag specifications at the end of this section to make sure your stock is compatible.

Antenna Label RFID Chip Antenna



20 | Using RFID (PC Only)

4 B	 Printing and Encoding
Once you have a successful write test, you are ready to print from your RFID equipped software program! Refer to the printing 
application’s documentation for details on RFID printing. A trial version of Bartender is included on the installation disc. You 
will have to start the 30-day trial on at least the Professional version to encode RFID.

To add RFID encoding to a label design using Bartender, once the label size has been chosen and the blank label is on screen, 
click the Standard RFID button on the lower left to display all RFID options. Simply drag the desired data format to the area 
around the label. Double click on the icon that appears to set the data or data source.

Note on Encoding Errors: 	During printing from any application if an encoding error appears, PrintHub will appear and display an 
			   error. It will try to encode again after making calibration adjustments. If it fails to encode, by default a  
			   series of XXXXs will automatically be printed on the label to indicate that it was not encoded properly. 
			   The job will then continue.

4 C	 Tag Specifications
Tags must meet the following specifications to be encoded using the RX500e:

	» EPC Gen 2 (v1.2.0) compliant
	» ISO/IEC 18000-6C compliant
	» 915 MHz (UHF)for USA (Requires USA version of RX500e)
	» 867 Mhz (UHF) for Europe (Requires European version of RX500e)

RX500e encodes only to EPC memory which can store from 96 bits to 480 bits depending on the tag that is chosen.

The chip (ICs) for Gen 2 tags contain four types of memory:

	» Reserved memory
	» EPC memory
	» TID memory
	» User memory
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Reserved Memory:

This memory bank stores the kill password and the access password (each are 32 bits). The kill password permanently disables 
the tag (very rarely used), and the access password is set to lock and unlock the tag’s read/write capabilities. This memory bank 
is only writable if you want to specify a certain password. Most users do not use this memory area unless their applications 
contain sensitive data. It cannot store information besides the two codes.

EPC Memory (RX500e Only Encodes this Memory):

This memory bank stores the EPC code, or the Electronic Product Code. It has a minimum of 96 bits of writable memory. 
The EPC memory is what is typically used in most applications if they only need 96 bits of memory. There are some tags that 
have the capability of allocating more bits to the EPC memory from the user memory. EPC memory is your first writable 
memory bank.

TID Memory:

This memory is used only to store the unique tag ID number by the manufacturer when the IC is manufactured. Typically, 
this memory portion cannot be changed.

User Memory:

If the user needs more memory than the EPC section has available, certain ICs have extended user memory which can store 
more information. When it comes to user memory, there is no standard in how many bits of memory are writable on each 
tag. Typically, the extended memory is no more than 512 bits, but there are some high memory tags with up to 4K or 8K 
bytes of memory. This is the second writable memory bank for Gen 2 ICs.

Note: 	 For specs on the physical placement of the tag on the label please see Label and Roll Specifications.
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Section 5:	Printing Using a PC
5 A	 Using BarTender®

Primera Special Edition BarTender UltraLite is included with the printer. Other programs can be used to print. If printing 

from other programs please follow the guidelines in Section 3D.

When you open BarTender you will be given the choice to select an existing label or create a new one using a wizard.

Download: https://portal.seagullscientific.com/downloads/bartender  Code: Z1J6-MY8X-N2B2-R2LH

1. Choose “Start a new BarTender document...”

2. Select “Blank Template”. Click “Next”.

3. Select “Color Label 500”. Click “Next”.

4. Select “Specify Custom Settings”. Click “Next”.

https://portal.seagullscientific.com/downloads/bartender
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5.	 Set the page size, width and height to match labels installed in the printer. Click “Next”.

6.	 Check the “Picture” box to add a background photo or graphic to your label. Click “Next”. If you click “Finish”, the remaining 
default wizard options will be set and no picture will be added.

7.	 Select “Embedded Picture”. Click the “File” Button to browse to the location of your photo/graphic file. Set the Size Method 
to “Stretch”. Note the preview to the right. Click “Next” if you are satisfied with the layout of the photo or graphic.
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8.	 Review the label setup summary. If it is correct, click “Finish”. Your blank label will be displayed.

After you click Finish, you can always go back and change any of these settings, by going to the File Menu and selecting 
“Page Setup”. Basic and advanced settings are available on the various tabs.

5 B	 Add Text, Barcodes and Graphics to a BarTender® Label
Once you have created your label size you will need to add text, a barcode and/or graphics. This can be done using one of 
the buttons on the button bar at the top of the screen.

Tip: Double-click any object to open settings for that object.

Tip: Go to the Help menu to access the BarTender Manual and Tutorials.

Add Graphic.  Click the Image 
button.  Now click anywhere on 
your label.  An Image icon will 
appear.  Double-click it to open up 
image settings and browse to the 
image/graphic that you would like 
to insert.

Add Barcode.  Click the Barcode 
button.  Now click anywhere on your 
label.  A barcode settings  
window will appear.  Here you can 
choose any type of barcode and enter 
the value.

Lines.  Click the Line button to 
add a horizontal or vertical line.

Print.  Click the Print button to 
start printing.

Page Setup.  Click the Page Setup 
button to change your label size, 
adjust corner radius or change the 
shape.

Add Text.  Click the Text button.  
Now click anywhere on your label. 
"Sample Text" will appear.  Edit the 
text on screen or double click it to 
open up text settings to change font, 
size and other settings.
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5 C	 Printing from BarTender®
1.	 To print, click the Print button or go to the File Menu and select “Print”. The Print Dialog window will appear.

2.	 Select the Color Label 500.

3.	 Set the number of copies.

4.	 Click “Document Properties” to adjust print quality settings. These settings are explained in the next section.

5.	 Click “Print”.

5 D	 Printer Driver Settings (PC)
Settings changed via the method below will apply to all new designs created in BarTender or other programs after the pref-
erences were changed. Existing labels saved in BarTender will not be affected since the preferences are saved with the label. 
To change these preferences you will have to change printer preferences through BarTender before printing by clicking the 
“Document Properties” button.

To find Driver Settings:

Click the Start button, choose Printers and Faxes. Right-click on the Color Label 500 Icon and select Printing Preferences 
from the drop-down menu.
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The preferences screen will appear.

NOTE on PC Settings:

Most applications allow you to change these same printer driver options from their “Print” screens. Some applications such 
as BarTender save your settings with the label, others use settings only for the current print job just sent to the printer.

Paper Size

If you are using BarTender, this setting is adjusted during the label setup wizard. If you are using a program other than Bar-
Tender you will need to set this to the dimensions of your label. Keep in mind that the dimensions are always relative to the 
width and height of the actual label in the printer. Orientation of an image on the label should not change this setting. See 
Section 6 for minimum and maximum label sizes.

Orientation

There are two settings for orientation, Portrait and Landscape. If your text and graphics print left to right or as shown on 
the screen, select portrait. If you wish your printing to rotate 90 degrees from what you see on the screen so it is printing

horizontally, select landscape as your orientation. Remember, this does not change the width and height in the Paper Size 
setting. It is only a tool for viewing a label upright on screen that will be printed sideways on the printer.

	 Portrait	 Landscape

Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print. Quality 1 provides the fastest print 
available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when 
designing your label to find a good balance between print quality and print speed.

Colour Matching

Best for Graphics mode is best used for graphical images where accurate colour reproduction is not as essential. Images 
printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of 
people may produce skin tones that have a reddish tint.

Best for Photos mode is best used for photographic images where accurate colour reproduction is very essential. Images 
printed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this 
mode.
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Note: 	 Exact colour matching of the printed labels to the screen may never be possible since there are factors that affect this out of 
	 the drivers control. The surface of the label reacts with the ink in the cartridge to produce the colour. For this reason, when  
	 printing the same image to different types of labels with different surfaces the printed output can look entirely different. 
	 screen that will be printed sideways on the printer.

Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the 
most accurate colour matching. If the ink is not drying fast enough or is bleeding, you can decrease the Ink Saturation to 
lessen the amount of ink that is applied to the label.

Enable Bidi (Bidirectional) Printing

Set to “Yes” for fastest print speed. Requires an alignment print after every cartridge change. Set to “No” for better quality print 
(in some cases). to one of DTM’s certified metallic, clear or spot colour ribbons.

Launch Status Monitor

Click here to open the LX500e Status Monitor. See section 3 for more details.

Details/Print Counter

Clicking on the Details button will allow you to view information about printer settings stored on the printer. There is 
also a print counter in the details window to help you count the number of labels printed since the last time it was reset.  
Click Reset Counter to set the counter to zero.

5 E	 Printing from other Programs
Since this printer uses a standard Windows printer driver you can print from any application you would like. There are just a 
few things to remember that will make it much easier.

1.	 Set the Page/Label Size in the Driver. BarTender automatically prompts you for the size of the label that you are 
using. When printing from any other program you must do this manually. Before you print, simply set the Paper Size 
just as you would set print quality in the printing preferences. In the example below the label size is 4” x 4” so the 
custom page size is set to 400 x 400 (displayed in .01 inch units).

2.	 Check the image or document size. The image size or document size should correspond to the Page/Label Size set 
in the driver. If you have set your page size n the driver to 4” x 4” but your image is actually 5” x 3” the printer driver 
will automatically shrink your image to fit inside the 4” x 4” label. The result is that the actual printed label is 4” x 2.4”. 
Avoid this by setting your page size in the driver and image size in the printing application to match the label size 
installed in the printer.

3.	 Choose the right printing program. There are many different applications that are capable of printing to the LX500e. 
However there are only a few that are ideal printing applications. For example, Adobe Illustrator is an excellent design 
program but is not always the best printing program. It can be difficult to find the printing preferences or to know 
the exact size of the art board. It is best to save as a PDF file and print from Adobe Reader or export as a 300 dpi JPG 
and print from BarTender.
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Section 6:	Printing from a Mac
6 A	 Printer Utility Settings (Color Label 500 Utility)

The Color Label 500 Utility is used to interact with the printer for gathering ink levels, maintenance, alignment, and several 
other functions.

To Find Color Label 500 Utility:

Color Label 500 Utility automatically installs with your printer driver and can be accessed through the Printer & Scanners in 
Mac under Apple Icon – System Preferences.

1.	 Connect the printer via USB and turn on the power. The Color Label 500 Utility accesses most of the information it uses 
from the printer itself so the printer must be turned on and communicating for the program to open.

2.	 Go to the Apple Icon – System Preferences - Printers and Scanners, select the PTI Color_Label_500, click on, Options & 
Supplies, and Open Printer Utility. Or you may simply print to the printer and the Utility will open. The Color Label 500 
Utility has 4 tabs that are arranged on the top of the window. Each tab opens a screen that has various similar functions.

	» Status Tab (First Tab). Displays ink levels, print counter and any error messages.
	» Cartridge Tab (Second Tab). Use for aligning the cartridge, cleaning the cartridge, and changing cartridge.
	» Alignment Tab (Third Tab). Adjusts vertical and horizontal print alignment. Changes the Stock Sensor Mode and toggles 

the Output/Cut Mode.
	» Settings Tab (Fourth Tab). Displays printer information including firmware version, driver version, and software version. 

Check for updates and set other advanced settings.
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6 B	 Adjusting Print Alignmemt/Label Offset
If your previous experience with printing is limited to printing letters and cards to 8.5 inch by 11 inch paper you probably 
are not familiar with an essential part of label printing – Print Alignment. Standard printers feed a sheet and start printing 
based on the start of the sheet. They also prohibit printing to the edge of the sheet. This is to avoid any need for alignment. 
The LX500e senses the beginning of the label with an optical edge. Because of this it is necessary to align the printer to 
work with specific types of label stock.

The LX500e comes from the factory calibrated to print exactly to the edge of Primera label stock. However, due to variability 
it may be necessary to fine tune these settings at the beginning of each roll. This is especially true for other non-Primera 
brand label stock.

Important Note: Before adjusting alignment settings first print one label at the quality level you intend for the entire print 
job. This will ensure the label stock is moving at the same speed and the stock sensor will sense the gap in the same way.

Important Note:	Before adjusting alignment settings first print one label at the quality level you intend for the entire print job. This  
		  will ensure the label stock is moving at the same speed and the stock sensor will sense the gap in the same way.

Adjust print alignment using the Color Label 500 Utility. Click on the Alignment Tab (Third Tab).

Three items can be adjusted here:

	» Tear off Position. This value adjusts the position of the last label printed after it has been presented for tear off. This 
only applies if the output mode is set to “Present.” Add to the current value to move the tear point closer to the printer. 
Subtract from the current value to move the tear point away from the printer. After adjusting the value click the Set 
Offsets button to send the value to the printer. 

	» Left Margin Offset. This value moves the printed label left or right. Add to the current value to move the printed label 
to the right. Subtract from the current value to move the printed label to the left. After adjusting the value, click the Set 
Offsets button to send the value to the printer. 

Note: 	 Before adjusting this value make sure the label stock is properly loaded so that there is no gap between the edge of the liner  
	 and the fixed throat guide. Any gap at this point will greatly affect the Left Margin Offset value needed to align the label.  
	 Also, if you adjust the value with improperly loaded label stock you will have to adjust it again if you load the label stock  
	 correctly the next time. 

	» Top of Form (TOF). This value moves the print start position up or down on the label. Add to the current value to move 
the printed label down or toward the printer. Subtract from the current value to move the printed label up or away from 
the printer. After adjusting the value click the Set Offsets button to send the value to the printer. 

You may have to make several adjustments to one or more of these values. After each adjustment you can click the Test 
Offsets button to print a small test pattern on the label. This will help you find the proper alignment value.



30 | Printing from a Mac

6 C	 Set the Stock Sensor Mode
The stock sensor mode refers to the method the printer will use to detect the print starting position for each label. To access 
the Stock Sensor Mode, click on the Alignment button, then select Stock Sensor Mode.  In most cases you will not need to 
change this setting.

Important Note:	 Set the Stock Sensor Mode BEFORE loading label stock! You must also set the Stock Sensor Position (Section 2B) 
		   so that the sensor is sensing the correct point on the label stock.

Die Cut (Default). If you are using standard die-cut labels that look similar to the graphic use this setting regardless of the 
size of the label. Also, use this setting for through-hole label material where a hole is punched through each label or a notch 
is cut on the side. 

Reflective. Use Reflective for label material where a black pre-printed line (black mark) on the back of the label stock indicates 
the break between labels. Black marks are required on clear label stock rolls, or labels where the label waste matrix (waste) is 
left on the liner. Black marks can also be used for irregular shaped labels, circles larger than 4.6 inches or on any stock where 
the print starting position can not be sensed using the label itself. 

Continuous. (Sensor off.) If you have continuous stock with no die-cut, reflective mark or holes, set the Sensor Type to 
Continuous. This will turn off the stock sensor. In this mode there is no way to set the print starting position. The printer 
will simply start printing the first label and print each subsequent label immediately after the previous. To produce a gap 
between prints simply add the desired amount of white space to the end of the label being printed. 

6 D	 Set the Output Mode
Use the Present/Cut Mode to adjust how the printer presents labels after they are printed or if/when they are cut after 
printing. There are different options available which change if the Cutter is enabled or disabled. If the Cutter is disabled 
the label present options will be available. If the Cutter is enabled the present options are are no longer available but cut 
options become available.

Cut Options (Check Cutter Enabled):

Cut after no activity. This setting will cut at the end of a print job if the printer does not receive another print job within 
one second of the last print job in the queue. You can usethis feature to cut at the end of multi-copy job, multi-page job or 
multiple individual jobs in the queue.

Cut after button press. This setting will cut after you press the Load/Feed button on the printer. This can be used after one 
label or an entire job. This feature is useful if you will not be present at the end of the print to catch the cut label. 

Cut every label. This setting will cut after every label. 
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Cut after label count. This option will cut after the number of labels specified in the toggle box that appears when this 
option is selected. This is useful if you have front/back labels or sets of labels.

Present Options (Uncheck Cutter Enabled)

Do not present. In this mode the label stock does not move after the last label is printed. This means that part of the last 
label printed is still in the printer. This should be used only if you have a label rewinder attached.

Present after no activity. This setting will present (feed all printed labels past the tear off point) at the end of a print job if 
the printer does not receive another print job within one second of the last print job in the queue. You can use this feature 
to present at the end of a multi-copy job, a multi-page job or multiple individual jobs in the queue.
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6 E	 Printing from Belight Swift Publisher
	 Swift Publisher is an affordable all-in-one desktop label printing software, which can be used with a Mac. It is very easy to 	
	 use and saves a lot of time. You can download the latest version of Swift Publisher at the website: www.belightsoft.com.
	 To setup a label and print follow these instructions: 

1.	 Open Swift Publisher software, select the category “Labels“ and open a new label.

2.	 Select the size of the label you want to print. You‘ve got many different sizes to choose from. You can also custom your own 	
	 size, if your size is not on the list. Click on “Custom“ and the “+“-symbol on the left.
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3.	 In this case, we select “Customize“. Now type in the width and height. In this example, we use a 4 x 3 in (101,6 x 76,3 mm) 	
	 label. Besides the label size, you can also change the page size, the layout and the Corner Radius, as well as the Outer and 	
	 Inner Radius. If everything is correct, click “OK”.

4.	 Now you can add images, text or barcode. If you want more information on how to setup a label and use the software, 	
	 contact Belight or visit the Help menu.
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5.	 When you are ready to print, click on “File - Print“.  Select the printer, adjust the print settings and press “print“. Now you can 	
	 adjust print settings. Alternatively, you can also click on the printer symbol. 
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6 F	 Create a Custom Label Size/Printing From Other Programs
In many programs such as Adobe Illustrator, Photoshop or Acrobat Reader you will need to choose your label/page size 
before you print.  If the label size you need to use is not already on the list of available pages sizes you will need to create a 
new custom size.

1.	 Open the program you would like to print from and select File – Page Setup.  Using the Paper Size drop down menu 
select Manage Custom Sizes. 

2.	 Add a New Custom Paper Size.  Click the plus (+) button to add a new custom paper size.  Enter the size on the right. Be 
sure to adjust the top, bottom, left and right margins to 0. Change the name from “untitled” to the size of your custom 
page (W x H).
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6 G	 Creating a Full Bleed Print
1.	 If you are having trouble making the image cover the entire label, first make sure the image is printing at least as big 

as the label size you have selected. Increase the selected page size by .03 inches on the width and .03 inches on the 
height to create an over bleed. 

Note: 	 Make sure under scaling options to select ‘Fit to Page’ in the print dialogue box if printing from Illustrator. 

	» Left Margin Offset. You must decrease the Left Margin Offset to center the over bleed on the label. If you over bleed 
by .03 inches, you will need to decrease the Left Margin Offset by 4. This will center the page size increase so there is 
an over bleed on both the left and right sides. 

	» TOF. Increase the Top Of Form by 4. This will cause the printer to start printing before the label and ensure a fully printed 
label.

Note: 	 It is best to over bleed as little as possible to avoid excess ink on the label backing. Also, over bleeding too much will cause  
	 the printer to skip labels. This is because the printer stops printing too late to sense the next label. 
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6 H	 Printer Driver Settings
Printer driver settings are accessible on the print window of any application right before you click print.  

Printing from Preview:

Click on the Layout dropdown menu and choose Printer Features.
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Printing from Adobe Reader:

First click on Printer... to access settings.  Click on the Layout dropdown menu and choose Printer Features.

Print Quality

There are 4 levels of print quality in the driver. The lower the Quality, the faster the print. Quality 1 provides the fastest print 
available while Quality 4 provides the best quality. It is recommended that you experiment with the different levels when 
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designing your label to find a good balance between print quality and print speed. 

Colour Matching 

Best for Graphics mode is best used for graphical images where accurate colour reproduction is not as essential. Images 
printed in this mode will look more vibrant because more ink is being used to produce them. However, printing images of 
people may produce skin tones that have a reddish tint. 

Best for Photos mode is best used for photographic images where accurate colour reproduction is very essential. Images print-
ed in this mode will look lighter than those printed in Photo mode. Skin tones especially will look more natural in this mode. 

NOTE: 	 Exact colour matching of the printed labels to the screen may never be possible since there are factors that affect this out of  
	 the drivers control. The surface of the label reacts with the ink in the cartridge to produce the colour. For this reason, when  
	 printing the same image to different types of labels with different surfaces the printed output can look entirely different.

Ink Saturation

This option controls the amount of ink used when printing an image. The default setting is 100%, which will provide the 
most accurate colour matching. If the ink is not drying fast enough or is bleeding, you can decrease the Ink Saturation to 
lessen the amount of ink that is applied to the label.

Enable Bidi (Bidirectional) Printing

Set to “Yes” for fastest print speed. Requires an alignment print after every cartridge change. Set to “No” for better quality 
print (in some cases).
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Section 7:	Troubleshooting
7 A	 Solving Offset/Alignment Problems

Image is Vertically Offset

(White space can be seen on the top or bottom of the label)

The LX500e decides where to start printing by detecting the start of a die-cut label, detecting a black mark on the back or 
detecting a thru-hole that corresponds to the start of the label.

The following items can cause the label sensor to improperly detect the start of a label:

1.	 TOF Offset.  TOF stands for Top of Form and this setting allows you to fine tune the alignment of your printing on your 
label stock.  This will be factory calibrated.  If fine tuning is needed, increase this setting to move the image down on 
the label; decrease this setting to move the image up on the label.  The unit of measure is 0.1mm.  

2.	 Nonstandard / Non-translucent Backing Material.  Test the unit with the label sample material that came with the unit.  
If it prints correctly, your label stock may not be compatible.  The label sensor needs to see the difference between a 
label and a backing material by seeing through the label stock for light variations.  If it can not see through the label, 
problems will arise.  If you must use this type of backing, try label stock that has a black mark on the back to show where 
the label begins.  You will need to change the Sensor Type setting in the driver preferences to Reflective if you switch 
to a label with a black mark on the back.

3.	 Improper Label Gap Distance.  See Section 8 for label specifications.

4.	 Page Size is Bigger than Label Stock Size.  If the page size set in the driver is larger than the actual label stock, ink will 
be printed on the gaps and the sensor will start looking for a gap too late.  This can cause label skipping or inconsistent 
print starting points. 

5.	 Portrait / Landscape.  If the Portrait / Landscape setting does not correspond to the label stock installed this will also 
cause the printer to print over the gap and onto the next label.  Make sure this is set correctly. 

6.	 Sensor Position.  Circular, nonstandard label shapes or multiple labels across will require precise adjustment of 
the label sensor.  If you are using circular or other non rectangular die-cut labels see Section 2B for instructions. 

The image is printing horizontally offset
(White space is seen on the left or right side of the label)

Two printer driver settings can affect this issue. 

Left Margin Offset.  This adjustment is found in the Status Monitor.  If you see white space on the right side of the label and 
overlap on the opposite side, increase the number.  If you see white space on the left side of the label and overlap on the 
opposite side decrease the number (Negative numbers are allowed). 

Note: 	Usually a space on the right side indicates a margin around the label that is not being accounted for.  The printer is factory  
	 calibrated for a 2mm margin.  A larger margin around the label will cause a right side space.

Page Size.  Often the page size is not large enough for the label.  If this is the case you may see white space on the right 
side of the the label and no image overlap on the opposite side.  This indicates that the page size needs to be increased.  
Increase the page size through the printer preferences enough to cover the label.
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7 B	 Creating a Full Bleed Print
1.	 If you are having trouble making the image cover the entire label, first make sure the image is printing at least as big as 

the label size you have selected.  To accomplish this using BarTender, make the image a few millimeters larger than the 
label by dragging the image over the edge of the label on all sides.  The bounding box around the image will turn red 
when it is over the edge of the label.  Try printing again to see if it covers the entire label. If not, move on to step two.

2.	 Adjust these settings in the printer driver preferences:

	» 	Page Size.  Increase the page size width in the driver preferences by .05 inches.  Increase the height by .05 inches. If you 
are using BarTender, simply change the size under the File Menu - Label Setup.  Increase the size of the image to fit the 
new larger page size.  If you are using other graphics programs you will need to change the page size in the application 
and in the printer driver preferences.

	» 	Left Margin Offset.  Decrease the Left margin offset by half the increase of the page size width. In this case you 
would decrease the value by 6 (which corresponds to .025 inches). This will center the page size increase so there is a  
.025 inch over bleed on both left and right sides.

	» 	TOF.  Increase the Top of form by 6.  This will cause the printer to start printing before the label and ensure a fully printed 
label.

Note: 	 It is best to over bleed as little as possible to avoid excess ink on the label backing.  Also, over bleeding too much will cause 
	 the printer to skip labels.  This is because the printer stops printing too late to sense the next label.

7 C	 Clearing a Label Jam
If there is a label jam in the printer mechanism first attempt to remove the jam by opening the cover and removing the jam 
from the printer feed output area.  

If the jam can not be located, it is possible to remove a cover over the feed input area.  Pull on the center of the cover as 
shown below to release the tabs on the sides. 

To prevent future jams, use rubbing alcohol to remove any adhesive left in the printer feed area.

PULL
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7 D	 Maintenance
Cleaning the Printer

The case of the printer can be cleaned with an ammonia based window cleaner and a lint-free cloth.

Over time, ink overspray may gather at the base of the printer.  The printer is designed using a vacuum system to gather 
most of this ink on a series of saturation pads.  Eventually, these pads may need to be replaced.  Contact tech support to  
determine if pad replacement is necessary. 

Maintenance Station Cleaning/Wiper Replacement

Check the Maintenance (Capping) Station for ink build up / Replace Wipers.  The capping station is where the cartridges 
dock when not printing.  The rubber cap just naturally builds up ink over time.  There can also be ink residue on the wiper.  
Wipe off the capping station components occasionally with a damp cloth.  The components that need cleaning include the 
cap itself as well as the rubber wiper just to the right of the cap. 

Wiper Replacement.

If you notice that the first few labels print fine and then the colours fade away, the wiper may actually need replacement.  
Wipers last approximately 30,000 prints.  However, actual wear will depend on several factors including the size of the label 
you are printing.  For this reason, the wiper should be cleaned and checked for wear every 10,000 prints.  A replacement 
wiper can be purchased from the replacement parts store.  SKU: 626367  Instructions for replacement can also be found on 
the parts store.

How will I know a wiper is worn?

The wiper has blades at the top that can get rounded over time.  This rounding can be very subtle when viewing only the 
worn wiper but when comparing a worn wiper to a new wiper the difference is noticeable.

Note: 	 These same symptoms can be caused by an empty cartridge.  Please ensure the cartridge has at least 20% ink remaining.  If  
	 not, please try a new cartridge.
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7 E	 Poor Print Quality – Cleaning the Cartridge
It may be necessary to clean the ink cartridge nozzles if you notice reduced print quality, or if you suspect a cartridge nozzle 
has become slightly dried out or clogged. If the cartridge has been left out of the printer more than 30 minutes, the ink in 
the print head nozzles may have dried. If you are having print quality problems, follow the steps below:

1.	 Before moving on to the next step, ensure that the ink level of the colour cartridge is more than 10%. If the ink level is 
lower than 10%, replace the cartridge. 

2.	 Try cleaning the cartridge using the clean function in the PrintHub or Printer Utility (Mac).  

3.	 Determine if printing is now acceptable by printing your image. 
If the sample has missing colours or voids within a colour strip, remove the cartridge from the printer and proceed to 
step 4.

4.	 Prepare items needed for procedure.
A Glass of WaterTwo Paper Towels

folded four times each
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5.	 Soak the paper towels in water for 5 seconds. 

 
Note:  Do not squeeze water from paper towels after removing from water.

6.	 Place one paper towel on cartridge nozzles.  Gently press the paper towel with your finger. Leave the paper towel on 
the nozzles for 30-40 seconds.

7.	 Wipe nozzles.

Cartridge Nozzles

Place one paper 
towel on nozzles

Gently press 
paper towel with 

finger

Leave paper 
towel on nozzles 

for 30-40 seconds

A. 	Place second paper towel on 
flat/hard surface.

B. Press the nozzles into the 
paper towel. 

C. Firmly tap the top of the 
cartridge three times to force 
the ink out.

D. Wipe/Drag the cartridge in 
the direction indicated.

E.  Repeat until all colors are 
seen on the paper towel.

After wiping the nozzles, the paper towel should 
show all three colors.  

If all three colors are present, proceed to step 8.

If the paper towel doesn’t show all three colors, 
then repeat step 7.

If paper towel still doesn't show all three colors 
repeating step 7, then replace the cartridge.
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8.	 Dry cartridge. 

9.	 Verify cartridge is now functioning properly by printing your label. 

7 F	 Technical Support
If you have difficulties operating your Printer, contact technical support using one of the methods listed below.

Source Location

Primera Knowledge Base www.primera.com/kb

BarTender Software Help files Open the software. Click on the Help Menu - BarTender Help

Email Support www.primera.com/contact_tech_support.cfm

Phone Support 763-475-6669 (Mon - Fri 8 a.m. - 6 p.m CST)

Chat http://www.primera.com/contact_tech_ 
support.php (Mon - Fri 8 a.m. - 6 p.m CST)

Dry excess water 
from cartridge. Ensure 
cartridge contacts are 
completely dry.  Printer 
damage may result if 
cartridge contacts are 
not completely dry.

Technical DTM Print Support

Contact the DTM Print support team mondays - thursdays from  
9:00 - 17:00 and fridays from 9:00 - 15:00 via phone	  
at +49 611 92777-0, use the online live chat on the webpage  
dtm-print.eu or write us anytime an email to support@dtm-print.eu.

This service is free for all our customers.

mailto:support@dtm-print.eu
http://dtm-print.eu/en/
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Section 8:	Label and Roll  
	 Specifications

Important!	 Test all custom made label stock with the intended printer before ordering large quantities!  Primera will only  
		  assume responsibility for custom label stock ordered from Primera.	

Label Width

Liner Width

Distance from
edge of Media

to edge of Label

Width of Opening

Black Mark 
Width

Gap Between 
Labels

Label Height

Distance from
edge of Media

Label Sensing Methods

Method 1: Label
Gap Sensing

Method 2: Width of 
thru-hole opening 
Sensing

Method 3: Re�ective/Black
Mark Sensing
(Black Mark must be printed
on back side of label stock)

Note: See table below for Max and Min values in inches and mm..



47 | Label and Roll Specifications

Max Min

Label/Print width 4.25” (108 mm) 0.75” (19 mm)

Liner width 4.25” (108 mm) 1” (25.4 mm)

Label height/length 24” (609.6 mm) 0.75” (19 mm)

Gap between labels 0.75” (19 mm) 0.10” (2.5 mm)

Width of thru-hole opening 0.5” (12.7 mm) 0.375” (9.5 mm)

Distance from edge of media
to edge of thru-hole

 
1.90” (48.3 mm)

 
0.20” (5.1 mm)

Reflective/Black Mark Width* Equal to distance between labels 0.10” (2.5 mm) 

Max Outer Diameter (OD) 5.0”(127 mm) N/A

Inner Core Diameter (ID) See roll specifications below

Stock Thickness** .0010” (10 mil) N/A

Distance from edge of media to edge 
of label

Printer driver assumes 2 mm gap. However, this is adjustable via the left margin 
offset. 

* The Reflective/Black Mark should be opaque to infared light.  The mark should be between the labels.  The end of the mark 
should correspond with the beginning of the next label. 

**This is the recommended maximum.  There are two factors that determine whether the printer will accept any particular 
stock thickness.

1.	 The ability for the printer to pull the paper through the print area.

2.	 The ability for the sensor to read through the backing if the sensor is set to die-cut.

If you are printing in continuous or reflective label sensing mode number 2 does not apply.  The fact that the printer must read 
through the backing in die-cut mode will limit the thickness much more than the printer’s ability to pull the paper through 
the print area.  However, if you adjust opacity level of the liner enough to allow the label to be seen by the stock sensor, 
the thickness will only be limited by the printer’s ability to pull it through the printer area.  For these reasons the weight or 
thickness of the liner is a variable that can not easily be defined.  Primera recommends and uses 40# liner with all label stock.

Roll Specifications

Label Side Out

Core I.D.
Core O.D.

Roll O.D.

Notes:
1. Label height <1.5” requires a 2.00” I.D. x 3.00” O.D. core.
 Label height >1.5” requires a 2.00” I.D. x 2.25” O.D. core.
2. Turret glue or 1/2”-wide 3M 928 double-sided removable tape must be 
 used to attach stock to core. Removable tape must be positioned across 
 full width of core. Other types of tape are not allowed.
3. End face of liner must align with end of core on both sides within 0.030”. 
 (Core width should be the same as liner width.)
4. Masking tape or equivalent may be used to secure label stock to outside of roll. 

2” 5”

Label Stock
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Section 9:	Technical Specifications
Print Method: 	 Inkjet

Print Resolutions: 	 4800 x 1200 dpi, 1200 x 1200 dpi, 600 x 600 dpi

Ink Cartridge:	 #53374 Colour (CMY)

Colours: 	 16.7 million

Media Types: 	 Roll-fed pressure-sensitive labels, roll-fed tags

Media Sensing: 	 Moveable see-through sensor for die-cut labels and reflective for  
	 tags with black stripe sensing

Ink Level Warning: 	 Calculates actual number of prints remaining based upon ink  
	 usage of graphics being printed (patent-pending)

Indicator Lights: 	 Power, Ink

Controls: 	 Ink, Load/Feed, Unload

Operating Systems: 	 Windows 7/8/10, Mac OS X 10.11or higher

Data Interface: 	 USB 1.1

Minimum System:	 Pentium® IV computer or better, 512 MB RAM, 5 GB free hard  
	 drive space, USB 1.1/2.0 port

Label Design 	 BarTender Ultralite Edition. 
Software: 	 Can also be used with most other popular Windows and  
	 Macintosh label design software programs

RFID Module: 	 Compliant with EPC Global Class 1 Gen 2  
	 and ISO 18000 -6B and -6C

Electrical Rating: 	 12 V DC, 5.0 A

Power Requirements: 	 100-240 V AC, 50/60 Hz, 60 watts

Certifications: 	 UL, UL-C, CE, FCC Class B

Weight: 	 3.17 kg 

Dimensions: 	 264 mm wide X 388 mm deep X 180 mm high (closed) 
	 17.4” high (open)

Warranty:	 One year, parts and labor
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